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1 Provisions

1.1 Scope of Applicability
This document applies to the software:

WAGO KNX DCA, Software Version 1.1.0.0

The software must only be installed and operated in accordance with the operating in-
structions. Knowledge of the operating instructions is required for proper use. You can
find all documents and information on the detailed product page.

Additional documents

Besides this documentation/online help, the following supplementary documents are
available:
• & WAGO Controller KNX IP Product Manual
• & Product manuals of the WAGO I/O modules used

You can find all documents and information at:

ü www.wago.com/knx

1.2 Intended Use
The software is an engineering tool and is used in conjunction with the KNX Association
ETS.

The software is used for planning, designing and commissioning KNX networks.

Software operation is only permitted if the system requirements and license conditions
are met.

Improper Use

Improper use of the software is prohibited.

Improper use occurs in particular in the following cases:
• Non-observance of the intended use
• Implementation of a Known Misuse
• Use of the software in areas with special risk that require continuous fault-free opera-

tion and in which failure of or operation of the software can result in an imminent risk to
life, limb or health or cause serious damage to property or the environment (such as
the operation of nuclear power plants, weapons systems, aircraft and motor vehicles)

Warranty and Liability

The provisions of the latest WAGO General Terms and Conditions of Deliveries and Ser-
vices (GTC) apply as well as the Software License Terms for Standard Software (SW-Li-
cense) applicable to software products und software embedded in WAGO hardware prod-
ucts, both available at: ü www.wago.com.

In particular, the warranty is void when:
• The software is improperly used.

https://www.wago.com/knx
http://www.wago.com
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• The defect is based on (customer-)specific specifications (hardware and software con-
figurations).

• Modifications of the hardware or software by the user or third parties were made that
are not described in this documentation and are at least responsible for the occurrence
of the defect.

Individual agreements always take precedence.

Obligations of the installer/operator

The responsibility for the safety of an installation or system assembled with the software
lies with the installer/operator.

The installer/operator is responsible for the proper installation and the safety of the sys-
tem. It must comply with the laws, standards, guidelines, local regulations, the state and
the rules of technology applicable at the time of installation and must observe the guide-
lines and instructions described in the operating instructions. The installation require-
ments of the approvals must also be met.

In the event of non-compliance, the software may not be operated within the scope of the
approval.

1.3 Typographical Conventions

Number Notation

100 Decimals: Normal notation

0x64 Hexadecimals: C-notation

‘100’

‘0110.0100’

Binary: In single quotation marks

Nibbles separated by a period

Text Markups

italic Names of paths or files

bold Menu items, entry or selection fields, emphasis

Code Excerpts from program code

> Selection of a menu point from a menu

“Value” Value entries

[F5] Identification of buttons or keys

Cross References / Links

Cross references/links to a topic in a document

Cross references / links to a separate document

ü Cross references / links to a website

Cross references / links to an email address

Sequence of Action
ü This symbol identifies a precondition.
1. Action step
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2. Action step

ð This symbol identifies an intermediate result.

Æ This symbol identifies the result of an action.

• Individual action step

Lists

• Lists, first level
– Lists, second level

Figures

Figures in this documentation are for better understanding and may differ from the actual
product design.

Warning Messages

 DANGER
Type and source of hazard

Indicates an imminently hazardous situation which, if not avoided, will result in death or
serious injury.

• Action step to reduce risk

 WARNING
Type and source of hazard

Indicates a potentially hazardous situation which, if not avoided, could result in death or
serious injury.

• Action step to reduce risk

 CAUTION
Type and source of hazard

Indicates a potentially hazardous situation which, if not avoided, may result in minor or
moderate injury.

• Action step to reduce risk

 NOTICE
Type and source of malfunction (property damage only)

Indicates a potentially hazardous situation which, if not avoided, may result in damage to
property.

• Action step to reduce risk
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Information Notices

 Note
Information

Indicates information, clarifications, recommendations, referrals, etc.

1.4 Legal Information

Intellectual property

The intellectual property of this document belongs to WAGO GmbH & Co. KG. The repro-
duction and distribution of its content (in whole or in part) is prohibited, unless otherwise
provided by statutory provisions, written agreements or this document. In case of doubt,
the written consent of WAGO GmbH & Co. KG must be obtained in advance.

Third-party products are always mentioned without any reference to patent rights. WAGO
GmbH & Co. KG, or the manufacturer of third-party products, retains all rights regarding
patent, utility model or design registration.

Third-party trademarks are referred to in the product documentation. The “®” and “TM”
symbols are omitted hereinafter. The trademarks are listed in the Appendix: 8 Protected
Rights [} 53].

Subject to Change

The instructions, guidelines, standards, etc., in this manual correspond to state of the art
at the time the documentation was created and are not subject to updating service. The
installer and operator bear sole responsibility to ensure they are complied with in their
currently applicable form. WAGO GmbH & Co. KG retains the right to carry out technical
changes and improvements of the products and the data, specifications and illustrations
of this manual. All claims for change or improvement of products that have already been
delivered – excepting change or improvement performed under guarantee agreement –
are excluded.
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2 Security

2.1 General Safety Regulations
• This documentation is part of the software. Therefore, keep the documentation for the

entire service life of the software. Pass on the documentation to the next user of the
software. In addition, ensure that any supplement to this documentation is included, if
necessary.

• Any actions related to the use of WAGO software may only be performed by qualified
staff with sufficient knowledge to use the respective PC system.
Steps in which files are created or changed on a PC system may only be performed by
qualified employees with sufficient knowledge in the administration of the PC system
used in addition to file creation or modification.
Steps that change the PC system’s behavior within a network may only be performed
by qualified employees with sufficient knowledge of administration of the responsible
network.

• Set up permissions management for authorized persons.
– Digital access may only be made by authorized persons.

• Comply with the laws, standards, guidelines, local regulations and accepted technol-
ogy standards and practices applicable at the time of installation.

2.2 Indirect Safety
• If automation solutions are implemented that can lead to personal injury or significant

property damage in the event of failure, you must take appropriate measures to ensure
that the system remains in a safe operating state even in the event of failure.

• Give all products in a network different IP addresses.
• Never connect a PC on which a DHCP server is installed to a global network. Larger

networks usually already have a DHCP server, which can cause collisions that lead to
network breakdown.

• Use only the latest security software.
• Uninstall or disable all software components or programs on your PC that are not re-

quired for the intended use.
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3 Overview
ETS (Engineering Tool Software) is software specifically developed for planning, project
design and commissioning of KNX networks. In the course of its development, ETS’s
functionality was optimized, and the latest version includes options for setting up, main-
taining, servicing and expanding KNX networks. The software integrates all the major
components of a KNX network, such as lines, devices and building areas, into an intu-
itive, easy-to-use package that can be used to set up or modify controllers and device be-
haviors. With the software, individual devices within the bus system can be programmed
and configured for targeted implementation of new requirements with minimum time and
effort. The manufacturer-independent design of ETS enables manufacturers in the build-
ing automation industry to integrate their devices into the ETS product database using
certified standards.

The control software WAGO KNX DCA represents an extension of the ETS product data-
base. The software enables configuration of WAGO KNX devices via ETS.

The WAGO KNX DCA software enables the use of the following WAGO KNX devices in
particular:
• KNX/EIB/TP1 Interface (Item No. 753-646)
• KNX TP Secure Interface (Item No. 753-1646)
• KNX IP Controller (Item No. 750-889)
• KNXnet/IP router (consisting of KNX/EIB/TP1 interface and KNX IP controller)

The key feature of the KNX/EIB/TP1 interface and controller software is the ability to map
WAGO network variables to communication objects one-to-one in ETS.

Operation as a KNXnet/IP router is not possible with the KNX TP Secure Interface mod-
ule.

Communication objects are given the same name as the network variables to which they
are mapped. This ensures that the WAGO software’s internal mapping is also repre-
sented within ETS.
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4 Requirements

4.1 System Requirements
The following system requirements apply to the WAGO KNX DCA software.

Table 1: Minimum System Requirements

Component Requirements

Operating System Windows 10 x86

Memory 2 GB

Free hard disk space 20 GB

Processor 4 CPU cores

Screen resolution 1366 × 768 pixels

Software The WAGO KNX DCA software requires the KNX As-
sociation's ETS (Engineering Tool Software) Version 6
or higher.

Interfaces A KNX interface, e.g., Controller KNX IP (Item No.
750-889) with KNX/EIB/TP1 interface (Item No.
753-646) as router, a KNXnet/IP-to-TP router or a
KNX-TP-USB interface

Licenses A KNX license is required to download or operate the
WAGO KNX DCA software (see ü https://
my.knx.org/de/shop/ets-apps).

Table 2: Recommended System Specifications

Component Requirements

Operating System Windows 11 x64

Memory 8 GB

Free hard disk space 30 GB

Processor 8 CPU cores

Screen resolution 1920 × 1080 pixels

Software The WAGO KNX DCA software requires the KNX As-
sociation's ETS (Engineering Tool Software) Version 6
or higher.

Interfaces USB (optional: a USB interface is required when using
a USB-KNX-TP interface)

Controller KNX IP (Item No. 750-889) as router

KNXnet/IP (optional: an Ethernet port is required when
using a KNXnet/IP router as an interface to the KNX
TP line)

Licenses A KNX license is required to download or operate the
WAGO KNX DCA software (see ü https://
my.knx.org/de/shop/ets-apps).

WAGO KNX modules 753-646 and 753-1646 Version 1.1 or higher can only be config-
ured in the ETS using the WAGO KNX DCA software.

https://my.knx.org/de/shop/ets-apps
https://my.knx.org/de/shop/ets-apps
https://my.knx.org/de/shop/ets-apps
https://my.knx.org/de/shop/ets-apps
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5 Function Description

5.1 Access to KNX Devices via ETS6
ETS provides the following options in order to access KNX devices within a bus system:
• Via USB
• Via ETHERNET (“KNXnet/IP” or “KNXnet/IP Routing”)

The ETS6-equipped PC used for project design must be connected to a KNX interface.
Within ETS6, an interface can then be configured via the “Bus” tabs > Connections > In-
terfaces > Configured Interfaces > [+].

If the Controller KNX IP functions as a KNXnet/IP router, you can connect it directly to a
standard ETHERNET interface on your PC using an RJ45 cable.

In this case, ETHERNET is routed to Twisted Pair and Twisted Pair to ETHERNET via
the Controller KNX IP (Item No. 750-889) and the KNX/EIB/TP1 interfaces (see also
8 Parameterize the KNXnet/IP Router in ETS6 [} 48]).

You can find more information in:
• 8 ETS6 Start View [} 26]

5.2 Interworking Data Point Types (DPTs)
DPTs describe defined formats and data widths of communication objects.

The KNX module supports the following KNX data widths:
• 1 … 7 bits
• 1 … 4 bytes
• 6 bytes
• 8 bytes
• 10 bytes
• 14 bytes

5.3 Network Variable Name Syntax
Each network variable name contains the so-called program name. It is prefixed and sep-
arated from the actual name by a period.

5.3.1 Syntax for Simple Variable

The syntax for simple variable names is:

<program name>.M<No1>_<No2>_<basic name>

Table 3: Syntax for Simple Variable

Placeholder Length Explanation

<No1> Digit KNX module number

<No2> 3 digits Data address



Function Description

4029583371 | 1 | en-US | 2025-03-19 16:48 13
Product manual | WAGO KNX DCA

5.3.2 Syntax for Array Variable

The syntax for array variable names is:

<program name>.M<No1>_<No2>_<basic name>[<N3>]

Table 4: Syntax for Array Variable

Placeholder Length Explanation

<No1> Digit KNX module number

<No2> 3 digits Identifies variable array

<No3> Digits Identifies variable in array

5.3.3 Syntax for Nested Variables

The syntax for names of nested variables is:

<program name>.M<No1>_<No2>_<basic name>[<N3>]

Table 5: Syntax for Nested Variables

Placeholder Length Explanation

<No1> Digit KNX module numbers

<No2> 3 digits Identifies variable group

<No3> Digits Identifies variable in group

5.3.4 Syntax for Nested Array Variables

The syntax for names of nested array variables is:

<program name>.M<No1>_<No2>_<basic name>[<N3>]

Table 6: Syntax for Nested Array Variables

Placeholder Length Explanation

<No1> Digit KNX module number

<No2> 3 digits Identifies main group

<No3> Digits Identifies subgroup in main group

<No4> Digits Identifies variable and subgroup

5.3.5 Syntax for Short Name

By selecting the “Show Short Names” option in the knx interface (see 8 “Variable Prop-
erties” Area [} 30]), you can reduce the displayed length of the network variable names
by hiding the program name. This also removes the prefix, infix (in this case, the “period”
character between the basic name and suffix) and suffix.

The communication objects are also displayed in the ETS interface in a corresponding
shortened form.

The short form omits components of the name:
• Prefixed program name including separator
• Prefix for identifying the KNX module and index of the DPT function block
• Infix (between basic name and suffix) for identification in the event of nesting

Table 7: Syntax for Short Names – Long/Short Form of the Network Variable Name

Long Form Short Form

<Program name>.<basic name> <Basic name>

<Program name>.KNX<No>_<basic name> <Basic name>
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Long Form Short Form

<Program name>.M<No1>_<No2><basic name> <Basic name>

<Program name>.M<No1>_<No2><basic
name>[<No3>]

<Basic name>[<No3>]

<Program name>.M<No1>_<No2><basic name>.<suf-
fix>

<Basic name>.<suffix>

<Program name>.M<No1>_<No2><basic name>.<suf-
fix>[<No4>]

<Basic name>.<suffix>[<No4>]

5.4 KNXnet/IP Routing
The first KNX module after a Controller KNX IP (and, if applicable, other KNX-external
modules) extends the Controller KNX IP to function as a KNXnet/IP router. Any subse-
quent KNX modules operate in device mode. The KNXnet/IP router routes telegrams
from IP to a twisted-pair cable and vice versa.

You can find more information in:
• 8 Parameterize the KNXnet/IP Router in ETS6 [} 48]

5.5 Import/export functions
The import and export function makes it possible to restore previous configurations or
settings even after a new installation of the ETS, or to transfer them to another PC.

5.5.1 File Formats

The following file formats can be exported/imported with WAGO KNX DCA.

Table 8: File Formats

File Format Function/
Environment

Description

*.SYM_XML CODESYS V2.3
SYM_XML file

SYM XML files contain the CODESYS program’s symbol configuration and
thus the list of existing CODESYS variables.

*.xml CODESYS V3
SYM_XML file

SYM XML files contain the CODESYS program’s symbol configuration and
thus the list of existing CODESYS variables.

Note: Configuration files created in CODESYS V3 are no longer in
*.SYM_XML format, but rather *.xml format.

*.xml DCA backup
file

DCA backup files are used for saving all device settings. These include:
• Network variable assignment
• Network variable properties
• Network variable settings
• Assignment of communication objects to group addresses

Note: Importing the DCA backup file applies the predefined settings in the
devices and replaces any existing settings.

Note: Backups created with the WAGO ETS plug-in can be imported into
WAGO KNX DCA.
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File Format Function/
Environment

Description

*.csv CSV parameter
file

A CSV file can be used for parameter editing, since it contains all variables
visible in ETS in tabular form as ASCII text. CSV format is useful for editing
group address associations and other properties of network variables.

The imported CSV file must have been previously exported and, if applica-
ble, edited with Excel or a text editor. This method can be used to modify
group address associations and other properties of network variables.

The first line of a CSV file serves as a header and contains the property
names. Each additional row corresponds to a network variable. The property
values (table columns) are separated by semicolons.

A CSV file can be opened and edited with Excel or a text editor.

Note: The following parameters cannot be changed:
• Name
• Data type (DPT)
• CO number

Note: Unlike an exported XML file, a CSV file does not contain a fully speci-
fied configuration. Therefore, it is not suitable for the following activities:
• Transferring the configuration to another device
• Re-import after manual change of ETS visibility of variables
• Reimport after intermediate XML or SYM_XML import

Note: Excel cannot store additional information in CSV format, such as cell
formats, row heights or column widths. Therefore, when saving, confirm the
format warning prompt with “Yes” in order to retain *.csv file format.

You can find more information in:
• 8 Import Configuration [} 39]
• 8 “Import” Button [} 33]
• 8 Export Configuration [} 41]
• 8 “Export” Button [} 33]

5.6 Maximum Possible Number of Product Properties
The following table summarizes the maximum number of product properties for WAGO
KNX devices.

Table 9: Maximum Possible Number of Product Properties

Product Properties 753-1646 750-889

Communication Objects 253 1000 253

Associations 
(of group addresses)

253 2000 253

Group addresses 253 2000 253

Additional information can be found in the corresponding product manuals for the WAGO
KNX devices mentioned.
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6 Install

6.1 Download WAGO KNX DCA
ü A myKNX account is created on ü https://my.knx.org/.
1. Log into your myKNX account.

2. Purchase a license for the WAGO KNX DCA software from the KNX online shop.

3. From the top side menu, select the menu item “Account” > “Organization” > “Prod-
ucts” to select your purchased license for the WAGO KNX DCA software.

4. Download the WAGO KNX DCA software.

ð Proceed to the software installation steps (see 8 Install [} 16]).

Æ The WAGO KNX DCA software is downloaded.

6.2 Install WAGO KNX DCA
ü ETS6 is installed, and the Start view is open.
ü The installation file (WAGO-KNX-DCA.etsapp) is downloaded and is ready.
1. On the ETS Start view, click [Settings].

Figure 1: ETS6 Start View > “Settings” Button

ð The “Settings” dialog opens.

https://my.knx.org/
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Figure 2: ETS6 > “Settings” Dialog

2. Click the [ETS Apps] item within the sub-items of the Settings dialog.

ð An overview of installed apps appears in ETS.

Figure 3: ETS6 > Settings > ETS Apps (The WAGO KNX DCA software not installed)

3. Click [+ Install App].

ð A standard Windows dialog appears: “Select an ETS App.”

4. Select the WAGO-KNX-DCA.etsapp app installation file.
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5. Install the selected app installation file by clicking [Open].

ð The WAGO KNX DCA software has been added to the overview of installed apps.

Figure 4: ETS6 > Settings > ETS Apps (the WAGO KNX DCA software installed)

Æ The WAGO KNX DCA software is installed.
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7 Start
 Note

Autosave!

The ETS6 software saves projects automatically. This includes the configuration in the
DCA. Manual saving is not possible in the WAGO KNX DCA software.

7.1 Create a Project in ETS6
In this step, you can create a new KNX project in ETS6.

The following steps are performed in the course of this action. The illustrations and de-
scriptions of the individual dialogs for the action can be found in 8 Graphical User Inter-
face [} 26].
ü ETS6 is installed.
1. Launch the ETS6 software.

ð The Start view appears.

Figure 5: ETS6 Start View

2. In the Start view, click the [New Project] button in the “Local Projects” area.
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Figure 6: ETS6 Start View > “Local Projects” Area > New Project

ð The “New Project” dialog appears.

Figure 7: “New Project” Dialog

3. Assign a name for the project you want to create in the “New Project” dialog and
make the settings you want.

4. Confirm the settings by clicking [Create Project].

ð The new project is created and opens automatically.

ð The project is loaded, and the progress of the loading process is indicated.
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Figure 8: Progress of Loading Process: “Open Project”

5. Add at least one new building to the new project, as well as the building’s associated
structural elements: “Building Parts,” “Floors” and “Rooms.”

Figure 9: ETS6 > Create a New Building Structure

6. Add new devices to the rooms by dragging and dropping them.

Figure 10: ETS6 > Drag New Devices into a Room

Æ The project is created, and new devices have been integrated.
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7.2 Open a Project in ETS6
In this step, you can open an existing KNX project in ETS6.

The following steps are performed in the course of this action. The illustrations and de-
scriptions of the individual dialogs for the action can be found in 8 Graphical User Inter-
face [} 26].
ü ETS6 is installed.
ü A KNX project file (*.knxproj) exists.
1. Launch the ETS6 software.

ð The Start view appears.

ð If you have already imported the project you want into ETS6, proceed with step 4.

Figure 11: ETS6 Start View

2. In the Start view, click the [Import Project] button in the “Local Projects” area.
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Figure 12: ETS6 Start View > “Local Projects” Area > Import Project

ð A standard Windows dialog appears: “Open Project File.”

Figure 13: “Open Project File” Dialog

3. Select a KNX project file and import it by clicking [Open].

ð The project file appears in the “Local Projects” area as a new button and does not
need to be imported again in the future.
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Figure 14: ETS6 Start View > “Local Projects” Area > Newly Imported KNX Project

4. Click the button for the newly imported project.

Figure 15: Progress of Loading Process: “Open Project”

ð The project is loaded, and the progress of the loading process is indicated.

Æ The project is open.

7.3 Start WAGO KNX DCA in ETS6
The procedure for calling up the WAGO KNX DCA software in the ETS interface depends
on whether the software is already installed in ETS6. If the software is already installed,
follow the steps in 8 Starting with KNX DCA Installed [} 25].

If the WAGO KNX DCA software is not yet installed in ETS6, follow the steps in 8 Start-
ing without KNX DCA Installed [} 25].
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7.3.1 Starting with KNX DCA Installed
ü The WAGO KNX DCA software is installed.
ü An ETS project is opened.
ü A Version 1.1 device or higher is created in the project.
1. Switch to the Topology view in the ETS tree structure.

2. Select the device you want in the Topology view.

ð Note: The WAGO KNX DCA software is only suitable for devices Version 1.1 or
higher.

ð The “DCA” tab appears in the workspace.

3. If necessary, switch to the “DCA” tab.

ð The contents of the WAGO KNX DCA software appear in the workspace.

Æ The WAGO KNX DCA software is started.

7.3.2 Starting without KNX DCA Installed
ü An ETS project is opened.
ü A Version 1.1 device or higher is created in the project.
1. Switch to the Topology view in the ETS tree structure.

2. Select the device you want in the Topology view.

3. If necessary, switch to the “Parameters” tab.

ð A message appears in the “Parameters” tab in the workspace stating that the
WAGO KNX DCA software is required and a corresponding link for download.

Figure 16: ETS6 > “Parameters” Tab > Note and Download Link for the WAGO KNX DCA Software (Example
View for the 753-646 Module)

ð Note: The WAGO KNX DCA software is only suitable for device Version 1.1 or
higher.

4. Download the WAGO KNX DCA software according to the displayed note or the steps
in Downloading KNX DCA.

5. Install the software according to the steps in 8 Install [} 16].

6. Launch the WAGO KNX DCA software after installation according to the steps in
8 Starting with KNX DCA Installed [} 25].

Æ The WAGO KNX DCA software is started.
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8 Graphical User Interface
The WAGO KNX DCA software is an app extension for ETS6.

The description of the software's graphical user interface also includes some parts of the
ETS6 software to provide a better overview and to allow better naming for certain pro-
cesses.

The description of the graphic elements for the WAGO KNX DCA software can be found
at 8 “DCA” Tab (ETS6) [} 26].

8.1 ETS6 Start View

Figure 17: ETS6 Start View

8.2 “DCA” Tab (ETS6)

Figure 18: “DCA” Tab (ETS6) > WAGO KNX DCA Start View



Graphical User Interface

4029583371 | 1 | en-US | 2025-03-19 16:48 27
Product manual | WAGO KNX DCA

8.2.1 “KNX DCA” Main View

Figure 19: “KNX DCA” Main View

Pos. Description

1 “(EIB)KNX Data Types and (EIB)KNX Data Width” Area

2 “Network Variable List” Area

3 “Variable Properties” Area and “Device Configuration” Area

8.2.1.1 “(EIB)KNX Data Types and Data Widths” Area

The “Network Variable List” can be filtered by KNX data width or KNX data type using the
tree view in the “(EIB-)KNX Data Types and Data Widths” area. The KNX types represent
the available data point types within the ETS. Depending on which data type is marked,
only those network variables that correspond to the selected type appear in the “Network
Variables List.”

The “(EIB)KNX Data Widths” tree node allows you to filter the network variables by data
width and thus independently of the specific data type. This makes to possible to record
new data widths that still lack a type.

Only one attribute can be entered as a filter. Multiple selection is not possible in the (EIB)
KNX data types window.
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Figure 20: WAGO KNX DCA > “(EIB)KNX File Types and (EIB)KNX Data Widths” Area

A selection in the structure tree can be canceled by clicking on a higher-level node or by
clicking in the empty area within the “(EIB)KNX File Types and (EIB)KNX Data Widths”
area.

The footer of the “Network Variable List” area shows the number of selected network vari-
ables in the “(EIB)KNX File Types and KNX/EIB Data Widths” area.

Figure 21: WAGO KNX DCA > Number of Selected Network Variables in the “(EIB)KNX File Types and
(EIB)KNX Data Widths” area
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8.2.1.2 “Network Variable List” Area

This area displays a list of existing network variables and their properties in the
WAGO KNX DCA software. All available network variables that can be associated with
group addresses from ETS are listed here. These network variables each have a specific
data point type and can be filtered by this data type (see 8 “(EIB)KNX Data Types and
Data Widths” Area [} 27]).

The checkbox at the beginning of the line for each list entry specifies whether the corre-
sponding network variable in ETS is visible as a communication object and appears in the
topology list. Some of the current properties/values of the network variables, e.g., “Read
after Reset,” can be edited in the “Variable Properties” area. Multiple variables can be
edited simultaneously (see 8 “Variable Properties” Area [} 30]).

Figure 22: WAGO KNX DCA > “Network Variable List” Area

Designation
(Column)

Value Description

 / 
Checkbox for switching visibility in ETS on or off

# (Table row number) Sequential numbering of the table rows

CO (Communication object
number)

Communication object number in the ETS topology

The communication object number is assigned automatically.

Name (Network variable name) The network variable name is taken from CODESYS and prefixed
with the “Program Name.”

If the corresponding setting is made in the “Variable Properties”
area, only the short name appears, and the program name is hid-
den (see 8 “Variable Properties” Area [} 30]).

Type (Data point type name or,
if typeless, size + unit of
data width)

Data point type name

If the data point has no type, its data width is shown.

Send after re-
set

On/off Indicates whether the current value should be sent on the bus au-
tomatically if the fieldbus controller is reset.

This function can be used to initialize the corresponding group ob-
ject.

Read after re-
set

On/off Indicates whether the current value should be read from the bus
automatically if the fieldbus controller is reset.

This function can be used to initialize the associated function
block.

Timeout (Amount + unit) The data point has a watchdog and expects an update within the
specified time.
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Designation
(Column)

Value Description

Cyclic sending (Amount + unit) Time interval for repeated cyclic sending

Group ad-
dresses

(x/x/x) Assigned KNX group addresses

A data point can be linked to multiple group addresses. Associa-
tions between data points and group addresses are established in
the ETS Topology window.

The maximum number of group addresses can be found here
8 Maximum Possible Number of Product Properties [} 15].

See also

2 “(EIB)KNX Data Types and Data Widths” Area [} 27]

2 “Variable Properties” Area [} 30]

8.2.1.3 “Variable Properties” Area

The “Variable Properties” area displays the properties of the selected network variables.
The properties can be read or written here. The settings made are immediately updated
in the “Network Variable List” table.

To change the properties of multiple network variables at the same time, you can mark
multiple rows in the “Network Variables List” at the same time. Changes you make in the
“Variable Properties” area then apply to all network variables marked in the list. Check-
boxes for which the selected network variables differ are highlighted in blue.

The settings in the “Start Behavior” and “Time Response” sections relate to the network
variables selected.

Figure 23: WAGO KNX DCA > “Variable Properties” Area
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Designation Value Description Read/
Write

Name (Dialog
title)

If a network variable is selected:
Name of the selected network variable

R

If multiple network variables are selected:
Number of selected variables

Start Behavior
Send after reset Values are updated after a device reset.

Values are updated in the event of a power reset, node reset from
ETS and IEC application software reset.

R/W

Values are not updated after a device reset.

Read after reset The device reads the current value from the bus automatically af-
ter a device reset.

R/W

The device does not automatically read the current value from the
bus after a device reset.

Time Response
Time Base Sec. Change of the time base to seconds.

Only enabled if the Send Cyclically box or Timeout box is
checked.

R + R/W

Min. Change of the time base to minutes.

Only enabled if the Send Cyclically box or Timeout box is
checked.

Send Cyclically x The device sends its value to the bus at the interval set here. R + R/W

Timeout x After a period of time without a telegram update, the device indi-
cates a timeout on the corresponding FbDPT module in the PLC.
The data point has a watchdog and expects a program update
within the specified time.

R + R/W

8.2.1.4 “Device Configuration” Area

The settings in the “Device Configuration” section relate to the entire device.
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Figure 24: WAGO KNX DCA > “Device Configuration” Area

Designation Value Description Read/
Write

Device Configuration
Module Index x Selection of the KNX module number R + R/W

Note: This field does not appear during controller selection.

Note: The selected module index affects the network variable
names (see 8 Network Variable Name Syntax [} 12]).

Note: If you operate a KNX module as the second I/O module of
this type on a Controller KNX IP (Item No. 750-889), it functions
as an I/O module in device mode. In contrast, the first KNX mod-
ule works automatically in router mode. Although no access to the
first KNX module via an IEC application is possible, the following
second KNX module is addressed via index 2 (see also the man-
ual of the Controller KNX IP, item number 750-889).

Telegram
Delay

0 ms Selection of the minimum time delay that must be observed be-
tween successive telegrams.

Default value: 0 ms

R + R/W

50 ms

100 ms

250 ms

500 ms

1000 ms

1250 ms

1500 ms

1750 ms

2000 ms



Graphical User Interface

4029583371 | 1 | en-US | 2025-03-19 16:48 33
Product manual | WAGO KNX DCA

Designation Value Description Read/
Write

Show
Short Names

The network variable names are displayed in short form, e.g., “Fb-
DPT_Switch” instead of “PLC_PRG.M2_001_FbDPT_Switch.”

You can find further information in 8 Syntax for Short Name
[} 13].

R + R/W

The network variable names are displayed in complete form. R + R/W

8.2.2 “Import” Button

The “Import” button can be used to import a Sym XML, backup or CSV file.

Figure 25: “Import” Button

Clicking the “Import” button opens a standard Windows dialog, “Import Sym XML, Backup
or CSV File,” for selecting the file to be imported.

If network variables already exist in a project before an import, a prompt appears asking
whether the existing variables should be merged with the newly imported ones or whether
the new network variables should overwrite the existing ones in the project.

Figure 26: Note: “Merge Network Variables”

8.2.3 “Export” Button

The “Export” button can be used to export a backup or CSV file.

Figure 27: “Export” Button

Clicking the “Export” button opens a standard Windows dialog, “Export Backup or CSV
File,” for selecting the file to export.
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8.2.4 “Create PDF (by Network Variables)” Button

The “Create PDF (by Network Variables)” button can be used to create PDF documents.

Figure 28: “Create PDF” Button

Clicking the “Create PDF (by Network Variables)” button opens a standard Windows dia-
log, “Create PDF Documentation,” for selecting the storage location for the PDF docu-
ment to create.

8.2.5 “Create PDF (by Device Addresses)” Button

The “Create PDF (by Device Addresses)” button can be used to create PDF documents.

Figure 29: “Create PDF” Button

Clicking the “Create PDF (by Device Address)” button opens a standard Windows dialog,
“Create PDF Documentation,” for selecting the storage location for the PDF document to
create.

8.2.6 “About...” Button

The “About...” button can be used to access general information about the software, sup-
ported KNX modules, the manufacturer and support contact details.

8.3 “Parameters” Tab (ETS6)

 Note
Function depends on the KNX module used

The “KNXnet/IP Router” function can only be used with the KNX module 753-646.

On the “Parameters” tab, you can set up a KNXnet/IP router and adapt its IP parameters
to the network.
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Figure 30: “Parameters“ Tab

8.3.1 “Advanced Settings” Sub-Item

Under the “Advanced Settings” sub-item, you can view and set general data such as the
device name, project number and installation number.

Figure 31: “Parameters” Tab > “Advanced Settings” Sub-Item

Parameters Description

Device Name Freely selectable device name of at most 30 characters to identify the device in ETS

Bus Power
Failure

Behavior of the device in the event of bus power failure

Disabled Power failure and power recovery are not reported.

Enabled Failure and recovery of the power on the bus line are reported by
KNXnet/ IP (default).
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Parameters Description

Routing Multicast
Address

IP address for KNXnet/IP routing:
• Address reserved for KNXnet/IP: 224.0.23.12
• General address: 239.0.0.0 ... 239.255.255.255
• Valid address range: 224.0.0.0.0 ... 239.255.255.255

Project Number* Project number setting

Value range: 0 ... 4096

Installation
Number*

Installation number setting

Value range: 0 ... 15

* These settings are only required if the project contains more than one router!

8.3.2 “IP -> TP” Sub-Item

In the “IP -> TP” sub-item, you can set parameters for filtering and telegram confirmation
that are sent from the IP medium to twisted pair (TP).

Figure 32: “Parameters” Tab > “IP -> TP” Sub-Item

Parameters Adjustable Parameters Description

Individually Addressed
and Broadcast Tele-
grams

Forward All telegrams are for-
warded.

Using this selection box, you can
specify how the physically addressed
telegrams and broadcast telegrams
should be filtered.

Lock No telegram is 
forwarded.

Filter
(Normal)

Filtering is performed on
the basis of the filter table.

Group Telegrams of
Main Groups 0 to 13

Forward All telegrams are for-
warded.

Using this selection box, you can
specify how the telegrams of main
groups 0 to 13 should be filtered.Lock No telegram is 

forwarded.

Filter
(Normal)

Filtering is performed on
the basis of the filter table.

Group Telegrams of
Main Groups 14 to 31

Forward All telegrams are 
forwarded.

Using this selection box, you can
specify how the telegrams of main
groups 14 to 31 should be filtered.
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Parameters Adjustable Parameters Description

Lock No telegram is 
forwarded.

Filter
(Normal)

Filtering is performed on
the basis of the filter table.

8.3.3 “TP -> IP” Sub-Item

In the “TP -> IP” sub-item, you can set parameters for filtering and telegram confirmation
that are sent from the medium twisted pair (TP) to IP.

Figure 33: “Parameters” Tab > “TP -> IP” Sub-Item

Parameters Adjustable Parameters Description

Telegram Confirmation
of Group-Oriented Tele-
grams

Always All telegrams are con-
firmed.

Using this selection field, you can
specify how telegram confirmation
should be performed for group-ori-
ented telegrams.

Only When 
Forwarding

All forwarded telegrams
are confirmed.

Physically Addressed
and Broadcast Tele-
grams

Forward All telegrams are for-
warded.

Using this selection box, you can
specify how the physically addressed
telegrams and broadcast telegrams
should be filtered.

Lock No telegrams are for-
warded.

Filter 
(Normal)

Filtering is performed on
the basis of the filter table.

Group Telegrams of
Main Groups 0 to 13

Forward All telegrams are for-
warded.

Using this selection box, you can
specify how the telegrams of main
groups 0 to 13 should be filtered.Lock No telegrams are for-

warded.

Filter 
(Normal)

Filtering is performed on
the basis of the filter table.

Group Telegrams of
Main Groups 14 to 31

Forward All telegrams are for-
warded.

Using this selection box, you can
specify how the telegrams of main
groups 14 to 31 should be filtered.Lock No telegrams are for-

warded.
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Parameters Adjustable Parameters Description

Filter 
(Normal)

Filtering is performed on
the basis of the filter table.



Operation

4029583371 | 1 | en-US | 2025-03-19 16:48 39
Product manual | WAGO KNX DCA

9 Operation
 Note

Autosave!

The ETS6 software saves projects automatically. This includes the configuration in the
DCA. Manual saving is not possible in the WAGO KNX DCA software.

9.1 Import Configuration
Operation of a KNX bus module and a Controller KNX IP requires specific configurations.
These are generated with CODESYS and exported to a symbol file. Under CODESYS
V2.3, these symbol files are saved in “*.SYM_XML” format. In CODESYS V3, these files
are saved in “*.XML” format.
ü The WAGO KNX DCA software is installed.
ü An ETS project is opened.
ü A Version 1.1 device or higher is created in the project.
ü There is an exported configuration file.
ü The module index is correct for the device to be exported.
1. Select the corresponding device in the “Devices” area of the ETS – TP1 module

(753-646) or KNX TP Secure Interface (753-1646).

Figure 34: ETS > “Devices” Area

ð The contents and setting options of the device appear in the workspace.

ð When a device is initially configured, a link to import a configuration file
(SYM_XML or xml file) appears in the workspace instead of the device settings. If
this is the case, you can import the file via the direct link and ignore the further
steps.
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Figure 35: Direct Link to Import a Configuration File during Initial Device Configuration

2. In the workspace, select the “DCA” tab in the top row of tabs.

Figure 36: ETS > “DCA” Tab

ð The settings options for the WAGO KNX DCA software appear in the workspace.

3. Select the “Import” button in the lower tab row.

ð Before starting the import, check whether the module index for the device is set
correctly (see 8 “Device Configuration” Area [} 31]).

Figure 37: Software WAGO KNX DCA > “Import” Button

ð A standard Windows dialog appears: “Import Sym_XML, Backup or CSV File.”

Figure 38: Standard Windows Dialog: “Import Sym XML, Backup or CSV File” > File Selection

4. Select the file to import.

5. Start the import by clicking [Open].

ð If network variables already exist in the project, a prompt asks whether they
should be merged with the newly imported network variables or whether the net-
work variables that already exist in the project should be overwritten.
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Figure 39: Note: “Merge Network Variables”

Æ The configuration is imported.

9.2 Export Configuration
ü The WAGO KNX DCA software is installed.
ü An ETS project is opened.
ü A Version 1.1 device or higher is created in the project.
1. Select the corresponding device in the “Devices” area of the ETS – TP1 module

(753-646) or KNX TP Secure Interface (753-1646).

Figure 40: ETS > “Devices” Area

ð The contents and setting options of the device appear in the workspace.

2. In the workspace, select the “DCA” tab in the top row of tabs.

Figure 41: ETS > “DCA” Tab

ð The settings options for the WAGO KNX DCA software appear in the workspace.

3. Select the “Export” tab in the lower tab line.
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Figure 42: The WAGO KNX DCA software > “Export” Tab

ð A standard Windows dialog appears: “Export Backup or CSV File.”

Figure 43: Standard Windows Dialog: “Export Backup or CSV File” > Name Entry

4. Enter a name for the file to export.

5. Start the export by clicking [Save].

Æ The configuration is exported.

9.3 Associate Network Variables and Group Addresses
The basic task of the ETS software is to visualize the associations between network vari-
ables of the KNX module or Controller KNX IP and the group addresses in ETS and to al-
low them to be edited.

9.3.1 Creating an Association

Create an Association by Dragging and Dropping

Associations between communication objects and group addresses are created by drag-
ging and dropping in ETS.
ü An ETS project is opened.
ü A Version 1.1 device or higher is created in the project.
ü A configuration with network variables and group addresses has been created/im-

ported.
1. In ETS6, open the “Topology” view.

2. In ETS6, also open the “Group Addresses” view.

3. Holding the right mouse button down, drag the network variable of your choice from
the “Topology” view to the group address of your choice in the “Group Addresses”
view.
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Figure 44: Create an Association by Dragging and Dropping

ð Note: Invalid association attempts are detected and indicated.

ð Note: If a group address is associated with a network variable, further network
variables must be of the same type for association with this group address.

Æ The association has been created.

Create an Association via the Context Menu

As an alternative to the drag-and-drop method, you can also create the association from
the context menu of the relevant communication object.
ü An ETS project is opened.
ü A Version 1.1 device or higher is created in the project.
ü A configuration with network variables and group addresses has been created/im-

ported.
1. Right-click on a communication object in the “Topology” view.

ð A context menu appears.

2. Select the [Associate with ...] menu item in the communication object’s context
menu.
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Figure 45: “Topology” View > Context Menu for Communication Object

ð The “Associate with Group Address” dialog appears.

3. To select an existing group address, use the list.

ð Within the list, you can search for group addresses using the “Search” field.

ð The selected group address appears in the dialog at the bottom of the “Group Ad-
dress” area.
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Figure 46: “Associate with Group Address” Dialog > Selecting Existing Group Address from List

4. Alternatively, you can create a new group address in the dialog at the bottom of the
“Group Address” area; this address is then associated with the network variable im-
mediately.

ð To create a new group address, enter the new group address to create and a
name in the two fields below.
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Figure 47: “Associate with Group Address” Dialog > Create a New Group Address

ð Note: The syntax of the group address is checked when entered. If the entry is in-
valid, the input field is outlined in red; no [Create & Associate] button appears.

ð If you have entered a correct group address (x/x/x) and a name (free text), the
[Create & Associate] button appears.

5. Click the [Connect] button if you have selected an existing group address, or the
[Create & Connect] button if you have entered a new group address.

Æ The association has been created.

9.3.2 Deleting an Association
ü An ETS project is opened.
ü A Version 1.1 device or higher is created in the project.
ü Associations exist between network variables and group addresses.
1. Right-click on an object in the Group Addresses view.

ð A context menu appears.

2. Click the [Disconnect] menu item to remove the association between the relevant
communication object and the group address.
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Figure 48: Delete an Association

Æ The association is deleted.

9.4 Create PDF Documentation
ü The WAGO KNX DCA software is installed.
ü An ETS project is opened.
ü A Version 1.1 device or higher is created in the project.
1. Select the corresponding device in the “Devices” area of the ETS – TP1 module

(753-646) or KNX TP Secure Interface (753-1646).

Figure 49: ETS > “Devices” Area

ð The contents and setting options of the device appear in the workspace.

2. In the workspace, select the “DCA” tab in the top row of tabs.
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Figure 50: ETS > “DCA” Tab

ð The settings options for the WAGO KNX DCA software appear in the workspace.

3. Select one of the two tabs “Create PDF (by Network Variables)” or “Create PDF (by
Device Addresses)” in the lower tab row.

Figure 51: The WAGO KNX DCA software > “Create PDF (by Network Variables)” Tab and “Create PDF (by
Network Variables)” Tab

ð A standard Windows dialog appears: “Create PDF Documentation.”

Figure 52: Standard Windows Dialog: “Create PDF Documentation”

4. Enter a name for the PDF documentation you want to create.

5. Start the process by clicking [Save].

Æ The documentation is created.

9.5 Parameterize the KNXnet/IP Router in ETS6

 Note
Function depends on the KNX module used

The “KNXnet/IP Router” function can only be used with the KNX module 753-646.

In this step, you can parameterize a KNXnet/IP router in ETS6.

The following steps are performed in the course of this action. The illustrations and de-
scriptions of the individual dialogs for the action can be found in 8 Graphical User Inter-
face [} 26].
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ü The project already contains a KNXnet/IP router.
1. Select the IP router in the ETS Topology area.

Figure 53: Structure Tree > Devices > Select Router

2. If necessary, switch from the “Communication Objects” tab to the “Parameters” tab to
display the device settings.

ð The following sub-items are visible: “Advanced Settings,” “IP -> TP” and “TP ->
IP.”

Figure 54: KNXnet/IP Router: “Parameters” Tab

3. Make the settings you want in the sub-items.

ð Detailed information on the settings options is available in 8 “Parameters” Tab
(ETS6) [} 34].

Æ The KNXnet/IP router is configured.
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10 Uninstall

10.1 Uninstall WAGO KNX DCA
ü The WAGO KNX DCA software is installed.
1. On the ETS Start view, click [Settings].

Figure 55: ETS6 Start View > “Settings” Button

ð The “Settings” dialog opens.

Figure 56: ETS6 > “Settings” Dialog

2. Click the [ETS Apps] item within the sub-items of the Settings dialog.

ð An overview of the apps installed in ETS appears.
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Figure 57: ETS6 > Settings > ETS Apps (WAGO KNX DCA Installed)

3. Select the WAGO KNX DCA software to use.

ð The [Uninstall] button appears.

4. Click [Uninstall].
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Figure 58: ETS6 > Settings > ETS Apps > Uninstall the WAGO KNX DCA Software

ð A note confirms that the software has been uninstalled.

Æ The WAGO KNX DCA software is uninstalled.
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11 Appendix

11.1 Protected Rights
• Adobe® and Acrobat® are registered trademarks of Adobe Systems Inc.
• AndroidTM is a trademark of Google LLC.
• Apple, the Apple logo, iPhone, iPad and iPod touch are registered trademarks of Apple

Inc. registered in the USA and other countries. “App Store” is a service mark of Apple
Inc.

• AS-Interface® is a registered trademark of the AS-International Association e.V.
• BACnet® is a registered trademark of the American Society of Heating, Refrigerating

and Air Conditioning Engineers, Inc. (ASHRAE).
• Bluetooth® is a registered trademark of Bluetooth SIG, Inc.
• CiA® and CANopen® are registered trademarks of CAN in AUTOMATION – Interna-

tional Users and manufacturers Group e.V.
• CODESYS is a registered trademark of CODESYS Development GmbH.
• DeviceNet® is a registered trademark of the Open DeviceNet Vendor Association, Inc

(ODVA).
• DALI is a registered trademark of the Digital Illumination Interface Alliance (DiiA).
• Docker® and the Docker® logo are trademarks or registered trademarks of Docker, Inc.

in the USA and/or other countries. Docker, Inc. and other parties may also have trade-
mark rights to other terms used herein.

• EtherCAT® is a registered trademark and patented technology licensed by Beckhoff
Automation GmbH, Germany.

• ETHERNET/IP™ is a registered trademark of the Open DeviceNet Vendor Association,
Inc (ODVA).

• EnOcean® is a registered trademark of EnOcean GmbH.
• flexROOM® is a registered trademark of WAGO Verwaltungsgesellschaft mbH.
• Google PlayTM is a registered trademark of Google Inc.
• IO-Link is a registered trademark of PROFIBUS Nutzerorganisation e.V.
• KNX® is a registered trademark of the KNX Association cvba.
• Linux® is a registered trademark of Linus Torvalds.
• LON® is a registered trademark of the Echelon Corporation.
• Modbus® is a registered trademark of Schneider Electric, licensed for Modbus Organi-

zation, Inc.
• OPC UA is a registered trademark of the OPC Foundation.
• PROFIBUS® is a registered trademark of the PROFIBUS Nutzerorganisation e.V.

(PNO).
• PROFINET® is a registered trademark of the PROFIBUS Nutzerorganisation e.V.

(PNO).
• QR Code is a registered trademark of DENSO WAVE INCORPORATED.
• Subversion® is a trademark of the Apache Software Foundation.
• Windows® is a registered trademark of Microsoft Corporation.
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